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1 Important information

Update

An update of Startup TOOLS does not change any data in the data packages
(<operatingenvironment >\ <application>\data\ <datapackage>) or the resource folder
(<operatingenvironment>\parametric\configuration\gt_resource_folder within an operating
environment. Data packages and resource directory are customized to company-specific
needs, e. g. the drawing frames, and must therefore be updated manually.

Please also consult the chapters Important informationen in GENIUS TOOLS Starter and for
Creo add-on applications in GENIUS TOOLS for Creo.
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2 New features

You can find more information about new functions in the chapters GENIUS TOOLS Starter
and for the Creo add-on applications in GENIUS TOOLS for Creo.
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3 License dependent funktions

The product functionality depends on the type of license you are using. Find the list of
functions that are limited to subscription licenses in the chapters Important Information in
GENIUS TOOLS Starter and GENIUS TOOLS for Creo respectively.
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4 Hardware and software requirements

Hardware and software requirements

GENIUS TOOLS Starter (GTS) works on all computers that fulfill the requirements for Creo
7.0 to Creo 12.1.

The following Windows server operating systems are supported for GENIUS TOOLS Starter
Service: Windows Server 2025 / Windows Server 2022.

The following requirements are the same for installation computers, installation computers
and satellites.

GENIUS TOOLS Starter

Version 7.0 8.0 9.0 10.0 11.0 12.0
Operating system | 64-bit only 64-bit only
Windows 10 /8.1 /7 |Windows 11/ 10
.NET Framework |4.8 4.8 Installation computer:
Delivered with Delivered with 4.8
Windows 10 -1903 Windows 10 -1903
(+8.1; +7)

(May have to be
installed separately
on WIN7/8.1)

NET - 8.0 (is included in the
GTS software setup )

Minimum screen | X=1280

resolution Y=1024

Flexnet INNEO Licence Manager 1.0 MO50 (Flexnet) and later
Caddepot circa 1 to 5 GB for each operating environment
directory

(Central storage
location with
UNC access)
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GENIUS TOOLS Starter

Cadpool Sufficient storage space to set up at least one operating environment
directory
(Storage location
on the
application
computer)

Data Windows computer, where the Caddepot directory is located and
synchronization | where a service can be installed.

using GENIUS
TOOLS Starter
Service

Operating Communication port for REST API on installation computer and
satellites using satellites. Standard: 8092

GENIUS TOOLS | Satellites need the same storage space as the installation computer.
Starter Service

Supported desktop applications

1. Administrators can create projects with object data and predefined configuration
settings for the following CAD applications:

— AutoCAD, AutoCAD Architecture, AutoCAD LT und AutoCAD Mechanical 2021 - 2026
— Creo Elements / Direct Modeling 17.0 - 20.8

— Creo Parametric 7.0 - 12.1

— Inventor 2021 - 2026

— SolidWorks 2020 - 2025

2. The following applications will be automatically detected if they are installed on the user
computer (autostart). The latest version will be opened.

— Creo Elements / Direct Drafting
— Creo lllustrate

— Creo Schematics

— Creo View

— Geomagic Design X

— KeyShot

Startup T00LS © 2025 INNEOQ Solutions GmbH
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— Mathcad

Required access rights

Caddepot
Read access: All users need read access to the Caddepot for synchronization to work.

Write access: For some functions users need write access to individual directories of an
operating environment in the Caddepot.

— GENIUS TOOLS Starter App feedback on the last synchronization
...\ serveronly\_SyncResults\

— Central user configuration files
...\userdata

— Common databases for GENIUS TOOLS for Creo name generation (has to be
configured manually)
...\serveronly\gt_numgen
Warning: This functionality cannot be used offline.

Cadpool

Read / write access: The user needs full write access to the local Cadpool for
synchronization to work.

Client computers
Write access: Write access needs to be granted to the following Creo installation
directories

— if more than the standard key (e.g. parametric.psf) or the synchronization of the start
key is to be used: to the directory that contains Creo startkeys,

— if the Creo configuration files config.sup, config.pro,
creo_parametric_admin_customization.ui need to be adapted: to the directory ..
\CommonfFiles\text

Please note: If Creo is installed into the Windows default program directory, you
should not make any changes with GENIUS TOOLS Starter App. Install Creo into
another directory, for example C:\ptc.

Startup TOOLS © 2025 INNEO Solutions GmbH 7
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9 GENIUS TOOLS Starter

GENIUS TOOLS Starter is the configuration component of the Startup TOOLS for version
6.0 and later.

GENIUS TOOLS Starter is a separate software that can start local applications such as Creo
Parametric using a central configuration, as well as synchronize data to the local
computer.

All projects and data are managed within a operating environment. You can now use any
number of operating environments in parallel, for example to have a test and production
environment.

GENIUS TOOLS Starter package

— GENIUS TOOLS Starter App is the interface for the user, who can start the projects
configured by the administrator. The local GENIUS TOOLS Starter App will update
automatically from the central Caddepot directory.

— GENIUS TOOLS Project Configurator is the tool for the administrator for configuring
projects that the user can then start using the GENIUS TOOLS Starter App.

— GENIUS TOOLS Environment Administrator is the tool for the administrator to manage
operating environments.

— With GENIUS TOOLS Config Editor administrators can directly compare and edit
configuration files and configuration blocks.

9.1 Important information

Environment Administrator: Older versions cannot be created (11.0.0.0
and newer)

With GENIUS TOOLS Environment Administrator 11.0.0.0 and newer, operating
environments of versions 10.0.2.0 and older cannot be created. This is due to the
migration to .NET 8.

Note that due to the conversion of the database in Release 9.0.0.0, versions older than
Release 9.0.0.0 cannot be created with GENIUS TOOLS Environment Administrator either.
See Important information: New folder structure not downward compatible.

Startup TOOLS © 2025 INNEO Solutions GmbH 8
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Different functionality depending on license type

Starting with version 6.0.1, perpetual licenses and subscription licenses come with different

product functionality.

The following functions are available with a subscription license for GENIUS TOOLS Starter.

Subscription
function

Dynamic access to
Windows user
management with
LDAP/Active
Directory
(lightweight
directory access
protocol)

Configuring units

Access to
directory “users”

Selecting Creo
startkey when
starting a project

Startup T00LS

Description Release

Creates access to Windows user management and 6.0.1.0
enables live queries so that user assignment is always
up-to-date. Users thus do not have to be created and

maintained manually.

= Less maintenance work

Adds a group element (“unit”) that can easily reflect 6.0.1.0
complex configurations such as for company sites and

units.

= Easier configuration for companies with many sites
and/ or units

= Allows for a reduction of projects

Adds a group element (“users”) that can easily reflect 6.0.1.0

complex configurations for many users.

= Less maintenance work

Provides a project with a choice from several Creo 7.0.0.0
startkeys (start command that opens Creo with a

defined license package). Users can start a project

with a default startkey or select another one when

opening a project in GENIUS TOOLS Starter App.

= Allows the reduction of projects

© 2025 INNEO Solutions GmbH
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Subscription
function

Apps projects

Operating
satellites in
GENIUS TOOLS
Starter Service

Edit and compare
configuration
blocks

Company-specific
project
collections

Selectable project
options

Reproducing
organization
structure with
units and subunits

Startup T00LS

GENIUS TOOLS™"

Description Release

Creates projects that run on any other program. 7.0.0.0
Assigning a project directory and batch files is
possible.

= GENIUS TOOLS Starter App can be made the
central access point for users.

Enables the connection of synchronization serversto ~ 7.0.1.0
a main server and their automatic synchronization.

= Faster connection of user computers to a
synchronized satellite

= Reducing queries from network to main server

Release-dependent config.pro editor and graphic 7.0.1.0
comparison tool (,Config Analyzer”, discontinued in
version 12.0.1.0)

= Quick overview, comparison and editing of project-
related configuration blocks (config_*.pro files)

Start projects can be put together in defined project 7.0.2.0
groups by the administrator.

= In many projects, these can be structured
according to your own requirements.

Projects can be started with multiple, individually 8.0.0.0
defined configuration blocks, e. g.for license
extensions or additional programs.

Subordinate units (subunits) can be created to 8.0.1.0
provide additional configuration levels for project
settings.

= Better mapping for locations, subunits etc. and the
resulting complex project configurations

= Allows for further reduction of projects

© 2025 INNEQ Solutions GmbH 10
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Subscription
function

Combined project
options

Edit config.pro
files in GENIUS
TOOLS Config
Editor

Auto projects

Create and
migrate Creo
Elements/Direct
Modeling
projects

Create SolidWorks
projects

Create Inventor
projects

Startup T00LS

Description

Users can select a project option in GENIUS TOOLS
Starter App, which activates multiple configuration
options which are located in different directories and
configuration levels, e. g. for license extensions and
add-on applications.

= Number of projects can be minimized

Creo configuration options can be edited faster with
auto-completion and color coding.

= Easier comparison and editing of configuration
options, also in batch mode.

Settings for auto projects (e. g. Keyshot) can be
specified for the configuration levels standard, unit,
project and user.

= Company-specific configurations possible
For Creo Elements/Direct Modeling projects, settings
can be specified for the configuration levels standard,

unit, project and user, and project settings and data
packages can be added or migrated.

= Integration of an additional CAD application

Projects for SolidWorks can be configured in the
layers standard, unit, project and user. Project settings
can be specified and data packages added.

= Integration of an additional CAD application
Projects for Inventor can be configured in the layers

standard, unit, project and user. Project settings can
be specified and data packages added.

= Integration of an additional CAD application

Release

8.0.1.0

8.0.2.0

9.0.0.0

9.0.0.0

9.0.1.0

9.0.2.0

© 2025 INNEQ Solutions GmbH 1
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Subscription
function

Create AutoCAD
projects

Support of
AutoCAD LT

Select alternative
authentication

Unit-specific
visibility of
projects

Install Creo
projects

SSO-
Authentifizierung

Synchronization
with
GitSynchronizatio
n with Git

Startup T00LS

GENIUS TOOLS™"

Description

For the applications AutoCAD, AutoCAD Architecture
and AutoCAD Mechanical, projects can be created for
a specific release and be assigned project and data
directories.

= Integration of an additional CAD application

Projects can be created for AutoCAD LT.

Users can authenticate against a system other than
Windows. Windchill user data can be imported with
GENIUS TOOLS Project Configurator. For other
systems, e. g. SAP, a self-created file can be used.

= Compatibility of Starter projects with other
authorization systems, e. g. Windchill

Access to a project can be restricted to a specific unit
(in addition to being restricted to a role).

= Use of units for project access

Synchronize Creo Parametric setups to user
computers, from which they can be started manually
or automatically.

Windchill user data can be authenticated with an
existing Windchill server with SSO (single sign-on)
setup.

= Login process in GENIUS TOOLS Starter omitted

Operating environments can be synchronized with the
version control system Git.

= Synchronization server can be accessed with URL
address

Release

9.0.2.0

10.0.1.0

10.0.1.0

11.0.0.0

11.0.0.0

11.0.1.0

11.0.1.0

© 2025 INNEO Solutions GmbH
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Subscription Description Release
function

Checking in Software component GENIUS TOOLS Git Utility for 12.0.0.0
changes to checking in changes made in an operating

GitChecking in environment to the version control system Git and the

changes to Git history of these changes.

= Intuitive graphical user interface

Warning: If you are using mixed licenses (perpetual and subscription) and configure
functionality that is limited to subscription licenses, the projects in GENIUS TOOLS
Starter App will no longer start if there is no subscription license available.

5.2 New features in version 12

Starter: New software component GENIUS TOOLS Git Utility (12.0.0.0)

GENIUS TOOLS Git Utility is an application for GENIUS TOOLS Starter which allows you to
check in changes made in an operating environment to the version control system Git and
which displays the history of these changes. GENIUS TOOLS Git Utility is opened in
GENIUS TOOLS Project Configurator with the function Git checkin in the sidebar.

Please note: If there is a disc icon L2] in the sidebar, you are not working in a git-
versioned environment.

The main page Commit lists all changed files in the operating environment. A distinction is
made between staged (1) and unstaged (2) files. Unstaged files can be filtered by modified
files 7, new files + and deleted files = and can be set to staged files by clicking the icon
i) (all files) or the icon N) (selected files).

Old versions of files can be deleted using function Purge operating environment b,

Enter a commit message and click the Commit button (3).

Startup T00LS © 2025 INNEO Solutions GmbH 13
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Staged files (2 Ul
configuration/database/sut.db -
+ parametric/configuration/standard/config_core.pro -
=+ parametric/configuration/standard/config_dir_file.pro -
=+ parametric/configuration/standard/config_piping.pro -

+ parametric/configuration/standard/config_sut_de_start_gtfe.pro —

Unstaged files ( Madified X}l |C+ New XT:] IC— Deleted Xj:fl e ,,TT ,A
Language
SHES User 3 i
urge operating
Theme menu b environment
Help r

Configure compare tool

PR e ration blocks (config.pro files)

@ Conet ana e

The History page 2l lists all commits of a working environment with the commit message
and details of the check-in date and author. The current status of a file can be compared
with a previous status of this file.

Further information can be found in the help document, which opens when pressing F1 or
under Help in the side bar.

Starter: New environment variables (12.0.0.0)
The following new variable is supported by GENIUS TOOLS Starter:

GTS_USER_EMAIL
Contains the email address of the user entry in GENIUS TOOLS Starter

Starter App: Time limit for pausing synchronization, button in sidebar
with new function (12.0.1.0)

The function Pause Synchronization can be limited in time in the user menu {3 for a
period of one hour, 9 hours, or permanently.

Startup TO0LS © 2025 INNEO Solutions GmbH 14
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Oo s
" Language r B
= Theme '
. Creo Parametric 12.0 Creo Parametric 11.0.1.0
Synchronize now (F&) e i :
P 1 hour
Pause synchronization (F7} * L 1.0 Creo Parametric 11.0.1.0
9 hours '
Debug Creo/Windchill - |
ause permanently .
Help b wu‘l’ndchill 10.0 EEDEIEIEI S TR
o Creo Parametric + Windchill in cloud
Open home . Creo Parametric 12.0 Creo Parametric 12.4.0.0
Open log file (F2) Latest Version
1 - ] INNEO - Creo Parametric 10.0 Creo Parametric 10050
L Version
. Reset window size B
Q ﬁ p @ y .g;, E{T +*  Default - parametricpsf -
Exit )
_ INNEO - Creo Parametric 9.0 D RIEEH AN,
-"0“‘: .
= Project Configurator (F8) Creo Version 9.0

O O Letzte Synchronisation: 03.11.2025 13:18:57

The function Synchronize Now can now — in addition to the user menu — also be activated
in the sidebar with the button &

The button replaces the Reload Projects  function, as changes are applied in real time,
see New features in version 12.0.1: Display of locally modifed files.

Starter App: Display of locally modified files (12.0.1.0)

Changes to files that configure a Starter project and are made locally are applied in real
time in GENIUS TOOLS Starter app. It is no longer necessary to reload projects. The
function Reload Projects C in the sidebar is replaced by the function Synchronize Now Q,
see New features in version 12.0.1: Button with new function.

Changes to configuration blocks and batch files are marked with icons in the Config and
Batch tabs. This makes it easier for administrators to test files before they are synchronized
to user computers.

If configuration blocks for Creo Parametric projects have been modified, they can be
opened directly on the comparison page of GENIUS TOOLS Config Editor by clicking the
button.

Startup TO0LS © 2025 INNEO Solutions GmbH 15
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Config

INNCO

& United_Kingdom  ~~

Creo Parametric 12.0
Latest Version

i LlQl@BsE S -

§¢E Create configuration files

= standard configuration blocks (.pro) standard

(=) Edinburgt
inburgh h Active Name Toolkit
- v GENIUS TOOLS for Crea |+ MP User N
1 Simulation v . -
¥ Keyshot 10 plugin & Toolkit d config_dir_file.ore  modified file 0
&F BMX «| & Simulation Live v '+ config_core.pro new file 0
| Favoritas & Manikin & MNotebook
= Unit configuration blocks (.pro) deutschland
2 Design Projects Creo Parametric 11.0 Active | Name Toolkit

Current version config_global.deutschland.pro o

‘4\ Synchronize now (F6)
Rl |mmediately starts synchronization + config_mapkeys.pro 0

Config tab in GENIUS TOOLS Starter App
The following icons can appear in the Config and the Batch tab:

New file File has been added.
Modified file File has been edited.

Incorrect batch GTS variables are overwritten in the batch file. In the case of start

file batch files, this may cause problems when starting projects.
Incorrect There are invalid characters (non-visible control characters) in the
configuration file. GENIUS TOOLS Starter removes these characters when

block creating the configuration files. The project can be started.

Starter App: Display of batch files (12.0.1.0)

The new Batch tab displays all batch files that apply to the selected project. These can be
pre-start, start, post-start, and stop batch files.

The tab is opened with the batch icon @ in the project area. It can be hidden by the
administrator. (New function right: Can view batch files)

You can deactivate the batch files by checking the checkbox and edit them by double-
clicking on the file name if you have the corresponding function right. (Can deactivate
batch files.)

There are new info icons for batch files for testing purposes, see New features in version
12.0.1.0: Display of locally changed files.

Startup TO0LS © 2025 INNEO Solutions GmbH 16
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e INR 01.0
INNCO =
- Start batch files
. Creo Parametric 12.0
Latest Version Active | Name
§ United_Kingdem
ﬁ P j @;; en v L standard\start_copy_fonts.bat
= L
Edinburgh ~ o 41 standard\start_test.bat
"4 GENIUS TOOLS for Creo |« MP User i )
@ Simulation e d standard\start_ifx_env.bat
Keyshot 10 plugi Toolkit o
SR Al @ T (49 units\deutschland\start_env.bat
& BMX | @ Simulation Live B
I Favorites & Manikin & Notebook Poststart batch files
Active = Name
S ANl . Creo Parametric 11.0 o
- ) . > i %) units\deutschland\poststart_gen.bat
urrent version o

Displa.y of batch files in GENIUS TOOLS Starter App

Settings in batch files can be created as project options, see New features in version
12.0.1.0: Creating project options for batch files

Starter App: Creating project options for batchfiles (12.0.1.0)

You can create batch files as project options by entering the available GTS config variables

",

with the comment characters “rem” or "::". The following variable is necessary:

rem gts is selectable = true (alternativ: :: gts is selectable = true)
Batch
. Creo Parametric 12.0 R
Latest version Active Name
i 2 e & &L HH +  Default - parametricpsf = standardstart_copy_fonts.bat
L standard\start_ifx_env.bat
v GENIUS TOOLS for Creo |« MP User Keyshot 10 plugin
L units\deutschland\start_env.bat
& Toolkit V| & AAX & Simulation Live
& Freestyle Design & Manikin | Copy fonts |

All GTS configuration variables can be found in the GENIUS TOOLS Starter Manual under
Making use of project options > Company-specific Project Options > Single Project Options.

Starter: Starter App Config Analyzer discontinued (12.0.1.0)

GENIUS TOOLS Starter App Config Analyzer is being discontinued. The functions available
in this tool for editing configuration blocks and comparing configuration settings between
two projects are now fully integrated into GENIUS TOOLS Config Editor.

This means that the Analyze button # in the info area of a project in GENIUS TOOLS
Starter App as well as the function access right Can analyze project in GENIUS TOOLS
Project Configurator are no longer available.

. Creo Parametric 11.0

Mew version

i 2 0d8 7B

Startup TOOLS © 2025 INNEO Solutions GmbH
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6 GENIUS TOOLS for Creo

The following section contains information on news for the Creo add-on modules GENIUS
TOOLS for Creo which are included in the products GENIUS TOOLS Parameter and GENIUS
TOOLS Library.

6.1 Important information

Updating GENIUS TOOLS Parameter & Library

An update of GENIUS TOOLS Parameter & Library does not update the resource folder
(gt_resource_folder). This must be updated manually. Consult the chapter Update process in
the help document GENIUS TOOLS Starter Installation.pdf

GENIUS TOOLS for Creo: No support fiir Creo version 11.0.0.0(12.0.1.0)

PTC Creo version 11.0.0.0 is not supported.

GENIUS TOOLS for Creo: End of support for Creo versions up to 9.x
(Version 12.0.0.0)

PTC Creo versions up to and including 9.x are no longer supported.

GENIUS TOOLS for Creo: Modules discontinued as of Creo release 13
(12.0.0.0)

The following GENIUS TOOLS extension modules will be discontinued as of Creo version
13.0.0.0, as the functions can now be executed with Creo Parametric.

GENIUS TOOLS for Creo Creo Parametric

Feature Regeneration Profiler Performance Report (in Tools >
Investigate)

Multibody to Assembly Save as assembly in a multibody part
(in File > Save as)

Export TDP: Directories must be renamed (12.0.0.0)

For Export TDP, the following subdirectories in export_tdp must be renamed in the
resource directory:

Startup TO0LS © 2025 INNEO Solutions GmbH 18
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Folder name: old Folder name: new
component chapters

model components
template templates

The following configuration options have been renamed:
Configuration option: old  Configuration option: new

gttdp_component_folder gttdp_chapter_folder

gttdp_model_folder gttdp_component_folder

The following details for the export templates have been renamed:

XML-Tags: old XML-Tags: new
frame format
XML-Attribute: old XML-Attribute: new
component definition

drwframe drwformat

Latex

@frame @format

License-dependent functions

The following functions are available with a subscription license for GENIUS TOOLS®
Library, GENIUS TOOLS® Parameter and Startup TOOLS.

Extension module Description Release
(GENIUS TOOLS

for Creo)

Load Save Converts Creo objects from previous Creo-, 7.0.0.0
Converter Wildfire- or Pro/ENGINEER versions to the currently

used version.

Startup T00LS © 2025 INNEO Solutions GmbH 19
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Extension module Description

(GENIUS TOOLS
for Creo)

Inspect Revision

Open Base Model

Extend Relations

Select Surfaces By
Color

CS Assembler

Extended
Dimension
Functions

Copy Component
Parameter To
Substitution
Component
Parameter

Toggle Symbol
Variants

Multibody to
Assembly

Startup T00LS

Release

Stores all versions of inspection symbols on a 7.0.0.0
drawing. Easily creates an overview of a revision
history.
Opens geometric base models that are reference 7.0.0.0
sources for features with one click in the context
menu of a feature.
Adds functions to model relations that define 7.0.0.0 -
parameters for models and — with Creo 7 — for 8.0.0.0
bodies.
Surfaces of the same color can be selected with one  7.0.1.0
click and be colored, measured or otherwise
modified thereafter.
Automates the assembly of components into an 7.0.1.0
assembly using defined coordinate systems (CS).
Model dimensions can be increased or decreased 7.0.2.0
very quickly with the mouse in a defined increment
in the graphics window.
If a value has been assigned to a component 7.0.2.0
parameter for a part in the master representation,
this value can be copied to the component
parameter for a simplified part.
If a grouped symbol has variants in the first level, 7.0.2.0
you can switch between those variants more
quickly.
Converts multiple bodies into assemblies (Creo 8.0.0.0
Advanced Assembly Extension (AAX) is required.)

© 2025 INNEO Solutions GmbH 20
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Extension module Description Release
(GENIUS TOOLS

for Creo)

Work Dir Automatically collects all directories used during 8.0.0.0
Manager the work process and enables the current working

directory to be changed quickly.

Full Backup Quickly backs up the current model with all 8.0.0.0
dependent data.

Command Creo Parametric ribbon commands / commands 8.0.1.0
Control can be hidden or deactivated.

Feature Regenerates models and displays regeneration 10.0.1.0
Regeneration times for each feature.

Profiler

Create offset Creates a coordinate system at the same location 12.0.0.0
point and offset (point, corner point, or coordinate system) within a

coordinate part or assembly, but with reference to a newly

systems selected reference coordinate system.

Stack Note Imports notes from a multilingual database; the 12.0.1.0

selection of notes is summarized in a note table and
can be placed next to a drawing.

Split Table Splits a table so that it is placed to the right or left 12.0.1.0
of it and can be repositioned.

Inspect Instance Inspection symbols and notes can be selected to 12.0.1.0
Note add a note. This shows which inspection symbols
belong to the respective pattern.

6.2 What's new in release 12

The following functions have been added to the GENIUS TOOLS add-on applications for
Creo that are are contained in the products GENIUS TOOLS Library and GENIUS TOOLS
Parameter and GENIUS TOOLS MBD for ISO GPS.
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Please note: If you would like to search for functions of a module across releases, enter
the name of the module in the search window in the Update Advisor
(https://updateadvisor.inneo.com). The Update Advisor also lists all changes to
configuration options and files in the supplied data packages.

6.2.1 Inspect

Inspect / Inspect 3D: Display of all tolerance values in compound frame
(Version 12.0.0.0)

For geometric dimensioning and tolerancing all tolerance values and datum references in
a compound frame are displayed and automatically read out.

Please note: The module Inspect is part of the products Startup TOOLS, GENIUS TOOLS
Parameter and GENIUS TOOLS Library, while Inspect 3D is a module of the new product
GENIUS TOOLS MBD for ISO GPS.

6.2.2 Orientation Manager

New module ,,Orientation Manager“ (12.0.1.0)

To start Orientation Manager 3%, click on the GT MBD ribbon and go to CREATE AND
SPECIFY section.

| Analysis Live Simulation Annotate Tools
| & 0o | == = — v
_Fn -\;._{L_h- D & B j —— ' ﬂ ﬂ‘_.-"
Function Orientation View Stack GTOL  GenTOL Find Annotation

Manager Manager Gallery Mote3D Text References References Info
CREATE AND SPECIFY -

With Orientation Manager, you can create and update model orientations and
automatically detect whether model orientations already exist. Associated annotation
planes are created for the defined projections, which are filtered when switching between
combined views in the Annotate tab. This makes it easier to select the annotation plane
when creating new annotations.
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GEMIUS TOOLS Orientation Manager 9 x GEMIUS TOOLS Orientation Manager o x
Crientations v Orientations [ 4
3D .
Create/Find v
Frant
General et
Left rajection
() Rectangle Projecti =
Back o ec ang e Projection ® Top
Bottom ® |sometric -
= . (! Bottom
|:|:I:||:| Default () Trimetric
Right
Top Reference 1: | Front -
Reference 2:
Mame: 01 -
Create Annotation Planes
+
"
Default Existing orientations

Used in CombViews: -

Create/Find [ 2

BENIUS TOOLS'™ Close | | GENIUS TOOLS™ Close

6.2.3 Stack Note

New module ,,Stack Note“ (12.0.1.0)

The new extension module Stack Note is used to select standardized information and
place them in a note on a drawing. The information elements are defined by the
administrator in a multilingual database and can, for example, contain information on
standards or regulations. The note can be exported and imported as an XML file. A symbol
in a note entry can be linked to a note, a dimension, or a symbol in the drawing.

Please note: GEN/US TOOLS Stack Note is only available with subscription license.

To start Stack Note ‘3, go in the GENIUS TOOLS ribbon to the APPS section.
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Layout Annotate Sketch Legacy Migration
— — — ] = e
il == ==l == 3 =& l
i ﬂ ﬂ == = = E—H j E E
Library ~ More  Pararmeter Forms UDF Dimension Stack Inspect Inspect
Libraries = Forms Mote Revision
APPS

User interface

The user interface of Stack Note consists of the following elements:

GENIUS TOOLS Stack Note | Help | @|x

D L\\) Mote: | StackNote_15 v | | Merge Changes | Table templates: o ﬁ |ﬁ EI ] : ‘T}
O 001 AuBenflichen frei von Trenngraten und Auswerfermarkierungen. TestUpdate

h Outer surfaces free at parting lines and ejector marks
O 006 Teile frei von Trennmitteln. Silikonhaltige Trennmittel sind nicht zuldssig.

- Part free of parting agents. Silicon parting agents are not allowed. e

© Dieses Dokument sowie die darin enthaltenen Daten, Spezifikationen und sonstigen
Informationen sind alleiniges Eigenturn der INNEC Solutions GmbH.
CR Eine Vervielfiltigung oder Weitergabe an Dritte ist ohne deren Zustimmung nicht gestattet.

\ ‘\f%Thiz docurmnent, as well as data, specifications and other information set forth in it, are the exclusive property of INNEO Solutions GmbH.
aJ'

y not be reproduced of given to third parties without its consent.

Symbol
placement

Filter: Category: | Copyright e A
© Dieses Dokument sowie die darin enthaltenen Daten, Spezifikationen und sonstigen
Informationen sind alleiniges Eigenturn der INNEQ Solutions GmbH. Note entry
& CR Eine Vervielfaltigung oder Weitergabe an Dritte ist ohne deren Zustimmung nicht gestattet, o
© This document, as well as data, specifications and other information set forth in it, are the exclusive property of INNEO Solutions GmbH.
It ray not be reproduced of given to third parties without its consent.

Note ID

EEMUSTUULSF e Create Cancel
1. Command bar and help button
Selection of note entries

Search input and category selection

> WD

List of all note entries. A note entry consists of the button for symbol placement, a note
ID, and the content in one or more languages.

5. Buttons for placing and updating the note and closing the window.

6.2.4 Stack Note 3D

New module ,, Stack Note 3D“ (12.0.1.0)

The new extension module Stack Note 3D is used to select standardized information and
place them in a note in a 3D model. The information elements are predefined by the
administrator in a multilingual database and can, for example, contain information on
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standards or regulations. The note can be exported and imported as an XML file.
Stack Note 3D is part of the new product GENIUS TOOLS MBD for ISO GPS.

To start Stack Note 3D '3, go in the GENIUS TOOLS ribbon to the CREATE AND SPECIFY
section.

| Analysis Live Simulation Annotate Tools
5 | + o0 L = = [ 7
= k oo- A/
fa < O 3 E 4 3] v

Function Orientation View  Stack GTOL GenTOL Find Annotation
Manager Manager Gallery Mote3D Text References References Info

CREATE AND SPECIFY -

User interface

The user interface of Stack Note consists of the following elements:

GENIUS TOOLS Stack Mote X

D L\\) Mote: | StackNote_15 v | | Merge Changes | Table templates: o |ﬁ % ﬁ-_ ‘TE
O 001 AuBenflichen frei von Trenngraten und Auswerfermarkierungen. TestUpdate
h Outer surfaces free at parting lines and ejector marks
O 006 Teile frei von Trennmitteln. Silikonhaltige Trennmittel sind nicht zuldssig.
- Part free of parting agents. Silicon parting agents are not allowed. e
© Dieses Dokument sowie die darin enthaltenen Daten, Spezifikationen und sonstigen
Informationen sind alleiniges Eigenturn der INNEC Solutions GmbH.
CR Eine Vervielfiltigung oder Weitergabe an Dritte ist ohne deren Zustimmung nicht gestattet. —

\ ‘\f%Thiz docurmnent, as well as data, specifications and other information set forth in it, are the exclusive property of INNEO Solutions GmbH.
aJ'

y not be reproduced of given to third parties without its consent.

Symbol
placement

Filter: Category: | Copyright e A
© Dieses Dokument sowie die darin enthaltenen Daten, Spezifikationen und sonstigen
Informationen sind alleiniges Eigenturn der INNEQ Solutions GmbH. Note entry
& CR Eine Vervielfaltigung oder Weitergabe an Dritte ist ohne deren Zustimmung nicht gestattet, o
© This document, as well as data, specifications and other information set forth in it, are the exclusive property of INNEO Solutions GmbH.
It ray not be reproduced of given to third parties without its consent.

Note ID

GENIUS TOOLS ™ o Create | | Cancel

1. Command bar and help button
Selection of note entries

Search input and category selection

> WD

List of all note entries. A note entry consists of the button for symbol placement, a note
ID, and the content in one or more languages.

5. Buttons for placing and updating the note and closing the window.
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6.2.5 Utilities

Utilities — New function ,,Create offset coordinate systems and
points“ (12.0.0.0)

The function Create points and coordinate systems &= can be used to create a coordinate

system or a point at the same location (point, corner point or coordinate system) within a
part or an assembly with reference to a newly selected reference coordinate system. The

offset coordinate system can be created manually or automatically or an offset point can

be created.

Please note: GEN/US TOOLS Create offset coordinate systems and points is only available
with subscription license.

The function is located in the GENIUS TOOLS ribbon in the UTILITIES segment under
Create.

View Flexible Modeling Applications GEMIUS TOOLS GT MBD

a . E] ,.-i_IJ A=] _—I ;*j__y ﬁ EI
Lil ‘—_J L J—% : 2 &’ m . o EJ_

v | Work Dir Open/Create  Full 3D Mote Create Editors
Iy | Manager Drawing Backup Form - =

UTILITIES = & Create offset coordinate systern (rmanuell)
& Create offset coordinate system (auto)
@ Create offset point

Utilities — New function , Find References” (12.0.0.0)

The new function Find References & has been implemented as part of GENIUS TOOLS
MBD for ISO GPS. The function is located in the GT MBD ribbon in the CREATE AND
SPECIFY section.

| Analysis Annotate Tools View
00 & & | = B
_Fﬁ Oe = *3 ' ﬂ{f

Function Combined GTOL GenTOL Find Annotation
Manager View Gallery Text References |References Info

CREATE AND SPECIFY =

Find References enables the automatic assignment of references to dimensions and finds
for displayed dimensions the corresponding semantic references. References which are
not found can be assigned manually. It also creates the semantic for Creo Parametric
model dimensions that represent ISO-GPS standards.
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GENIUS TOOLS Find References 9 Xx
¥— O—
Dimensien Value = Status  Type
DRV_DIM_D59 - d59 6.6 o H—H =
DRV_DIM_D207 - d207 n74 A =
DRV_DIM_D16 - d16 235 o @J =
DRV_DIM_D&1 - d&1 226.6 o @J =
DRV_DIM_D56 - d536 2348 o @J =
DRV_DIM_D49 - d49 220 o @J =
DRV_DIM_D108 - d108 204.5 o @J =
DRV_DIM_D241 - d241 210 o @J =
DRV_DIM_D242 - d242 212 o @J =
AE_DRIVEN_DIMZ - ad221 184 x H—H 7
AE_DRIVEN_DIM1 - ad216 1738 X @J v
DRV_DIM_D204 - d204 17 x H—H =
[T
GENIUS TOOLS ™ Reference Close |

Utilities — Combined View Gallery: Click sequence optimized (12.0.0.0)

If several combined views were added to the gallery, you can switch to the single view by
clicking on a combined view. With another click on the combined view, you switch to the
last used multiple view.

GNUSTOOLS CombiedViewGaley e-ax| T GEnUSTOOS Combnedvien Galey

o
alid < <> +

<<<<<

uuuuuuuuu

oo
EE 838 <[ <[> > +
GENII & o=

Multiple view After switching to the single view

Utilities — New function ,, Inspect Instance Note“ (12.0.1.0)

To start Inspect Instance Note [%, click on the GT MBD ribbon is in the APPLY AND EXPORT
section in the drop-down menu under Inspect.

Please note: GEN/US TOOLS Inspect Instance Note is only available with subscription
license.
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iew Flexible Modeling Applications Model

+ Size Table +% //// :F'
= (7]

= Surface Finish Table

Annotation Inspect Export | Editors
++ Update Tables Transtar = TDP -

APPLY AMD EXPORT Inspect 3D
E_' Inspect Instance MNote

E Inspect 30 Revision

With Inspect Instance Note, inspection symbols and notes can be selected to add a note.
This shows which inspection symbols belong to the respective pattern.

User interface

The user interface of Inspect Instance Note consists of the following elements:

GEMIUS TOOLS Inspect Instance Mote X

Select Elements: | Select Symbols [ Mote o

Index: 1 e
©

o Place Mote Close

Inspect Instance Note dialog box
1. Enables the selection of symbols or a previously created note.
2. Consecutive numbering of notes, starting with 1.

3. Displays the currently selected symbols and notes. This list determines which inspection
symbols are listed in the note.

4. Creates the note for placing at the desired positions; all entries from the list are output
with the current index. Quit the function by clicking Close.

Utilities — New function ,,Split Table” (12.0.1.0)

With Split Table, you can split a table and place the lower part to the right or left of the
original table. The newly created table can be repositioned. This function be opened in
Stack Note module in drawing mode.

Please note: GEN/US TOOLS Split Table is only available with subscription license.
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Please note: Split Table can be opened in Stack Note until Creo version 10.0.0.0 From
Creo version 11.0.1.0 onwards, it is also a standalone function.

User interface
The user interface of Split Table:

x

]

onfiguration\gt_resource_folder\stack_note\default.tbl| [=

GENIUS TOOLS'™" o | E | Close

Starting the program: in drawing mode
To start Stack Note 3, click GENIUS TOOLS in the ribbon menu and go to APPS section.

2 Layout Table Annotate Sketch Legacy Migration Analysis Review Model Processor
| == = == = =i = oy 7 B =
i = 0% H | 8E B L B
Library ~ More  Parameter Forms UDF Dimension| Stack |Inspect Inspect | Work Dir Create Update Full  Tableto | Editors !
Libraries ¥ Forms Revision | Manager Tolerance Table Tolerance Table Backup Excel ™ 4
APPS UTILITIES = EDUILLIHE

Starting via the GENIUS TOOLS in the ribbon menu
Click in the command bar on Split Table -

GENIUS TOOLS Stack Mote 9 x

D L\\) MNote: | - | | Merge Changes | Tabletemplates: | default - |ﬁ ﬁ ﬁ._ ‘TE

6.3 Configuration options

The following configuration options have been added, changed or deleted since version
12.0.1.0.

6.3.1 New configuration options (12.0.0.0)

Utilities: New configuration options

Combined View Gallery

gtu_combined_view_gallery_creation_rule
Defines a rule, in the form of a regular expression, to find combined views whose
screenshot is displayed when the program is started.
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GTOL Text

gtu_gtol_text_table_folder
Defines the path where the GTol Text tolerance table files are located.

gtu_gtol_text_lang
Defines the display language of GENIUS TOOLS GTol Text.

Find references

gtu_start_find_references
Defines whether GT Find References can be started by users (1) or by owner (0). Default: 1

Create point and coordinate systems

gtu_start_datum_creation
Defines whether the GT function to create offset coordinate systems and offset points can
be started by users (1) or by owner (0). Default: 1

gtu_datum_creation_std_placement_cs
Defines the name for the reference coordinate system. If the coordinate system cannot be
found a selection is requested.

gtu_datum_creation_start_feature_numbers
Defines the start for created features.

gtu_datum_creation_cs_prestring
Defines the name of the created feature. Default: MCS_

MCS_%gtu_datum_creation_start_feature_numbers%,
MCS_%gtu_datum_creation_start_feature_numbers% + 1,

gtu_datum_creation_pnt_prestring
Defines the name of the created feature. Default: PNT_

PNT_%gtu_datum_creation_start_feature_numbers%,
PNT_%gtu_datum_creation_start_feature_numbers% + 1,

CS Assembler

gtu_csassembler_use_std_ics_as_fallback
Defines, if a fallback coordinate system should be used (1) or not (0). This is defined by the
XML node std_ics_name. This must be clearly defined in the template assembly. Default: 0
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1 Contact details

Please don't hesitate to contact us for further information about our products.

United Kingdom
INNEO Solutions Ltd

60 Cygnet Court

Timothy's Bridge Road
Stratford-upon-Avon
Warwickshire CV37 9NW
Phone: +44 (0) 1564 793720
Fax: +44 (0) 1564 793872

Germany (Headquarters)
INNEO Solutions GmbH

IT-Campus 1

73479 Ellwangen

Phone: +49 (0) 7961 890-0
Fax: +49 (0) 7961 890-177

Www.inneo.co.uk
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8 Copyright

Copyright 2025 by:
INNEO Solutions GmbH
IT-Campus 1

73479 Ellwangen
Germany

This documentation is protected by copyright. All rights reserved. Without prior written
consent of an authorized representative of INNEO Solutions GmbH it must not be copied,
photocopied, reproduced, translated, communicated or converted to electronic or
machine readable form in whole or in part. The unauthorized use of the documentation
can lead to a claim for liquidated damages or legal prosecution. INNEO Solutions GmbH
does not accept liability for possible faulty information in this documentation and the
consequences resulting from such.

Note on registered trademarks:
Most of the software, hardware and trade names mentioned in this documentation are
registered trademarks of Parametric Technology Corporation (PTC) or a subsidiary.

Registered trademarks and trade names of INNEO Solutions GmbH:
GENIUS TOOLS, Startup TOOLS, INNEO
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